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August 20, 2019



Profex User Manual
Part 3: User Interface
Version 4.0

August 20, 2019
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1 Main Window

The program’s main window features a menu bar and several tool bars to access all functions and
settings (Fig. 1). The central area of the main window is occupied by the plot area, and optionally
one or several text editors, which are accessible by tabs at the top of the plot area. The plot area
cannot be closed, but text editors can be closed by clicking the close button on their tab.

The central area is surrounded by several dockable windows showing additional information and
giving access to more features. These dockable windows can be closed and opened from the
,,Window” menu. They can also be re-arranged (Fig. 2) by clicking on the title bar showing the
window’s name, and dragging it to another location. Dockable windows can be stacked on top of
each other to hide less frequently used windows, or detached from the main window, e. g. to be
placed on another screen, or closed.

1.1 User Interface Elements

The following list explains the elements of the user interface shown in Fig. 1 in more detail.

1 Menu and tool bars give access to most features, as well as the program’s preferences. All menu
items are explained in section 2.

2 Projects list lists all open projects and the refinement status. Selecting a project from this list
will make it the current project and show it in the central plot area. A right-click menu gives
access to more functions. Several projects can be selected for various actions, but only one
project can be the current project.

3 Plot options lists all scans loaded in the plot area. The ,,Show” checkbox can be used to
show/hide certain scans to customize the appearance of the plot. A right click menu is
available for direct access to certain functions.

4 Convergence progress shows the goodness of fit values Rwp. Rexp and χ2 of the running refine-
ment. A right click menu gives access to more functions. Clicking on the graph with the left
mouse button toggles between two predefined zoom states.

5 Refinement protocol shows output generated by the refinement backend.

6 Plot area displays raw or refined scans, and opens text editors for control files, results files,
structure files, or generic text files.

7 File tabs give access to all open files of a project. Files can be closed by clicking the⊗ icon. Note
that the first tab showing the graph cannot be closed. Double-clicking a tab synchronizes all
other open projects to show the same type of file.

8 Reference structure tool bar allows to select reference structures to display hkl indices, as well
as to start scanning and indexing new structure files. See section 1.5 for more information.
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9 Sample displacement tool bar shows the current amount of vertical sample displacement re-
sulting in horizontal shift of the diffraction pattern. The buttons allow toggling between 0
and the refined value.

10 Search-match This module allows to configure the search-match parameters (select database,
instrument, refinement parameters) and shows the score list after the search-match process
completes.

11 Global Parameters and GOALs shows a summary table of refined global parameters. Listing
EPS parameters can be configured in the program’s preferences dialog.

12 Status bar shows various information such as mouse cursor coordinates on the graph, and the
wavelength used to transform 2θ angles to d values.

(not shown) Context help shows the context help text when pressing ,,F1” on a keyword in a
control file.

(not shown) Local Parameters and GOALs shows a summary table of refined local parameters.
The parameters shown here can be customized in the program’s preferences dialog.

(not shown) Chemical composition shows the bulk chemical composition of all crystalline
phases, calculated from refined crystal structures and phase quantities.

(not shown) Peak integrals shows the currently defined peak integrals.

(not shown) Peak detection Shows list of peaks detected by the peak detection function (,,Run→
Peak detection”).

1.2 Dockable windows

All windows arranged around the central plot and editor area (no. 2–5, 10, 11 in Fig. 1) can be
rearranged or closed to match the user’s preferences. They are called dockable windows, because
they can be docked to different areas of the main window. Some examples are shown in Fig. 2 and
explained below:

Moving: Grab the dockable window at it’s title bar (e. g. the bar (green rectangles on Fig. 2) and
drag it to a different location. If the window can be docked, the area will be highlighted.

Stacking: Drag the dockable window onto another dockable window. The dragged window will
be stacked on top. Tab buttons will automatically appear to give access to both windows.
Unlimited numbers of windows can be stacked.

Detaching: Drag a window outside of the main window and release it when no dockable area is
highlighted. The window is now detached from the main window and floating freely on the
screen. Use this configuration to place windows on a second screen. Detached windows can
also be stacked. Drag the detached window back into the main window to dock it.

Closing / Opening: Dockable windows can be closed by clicking on the close button (x) in the title
bar. To open it again, use the menu ,,Window” in the main window’s menu bar.
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1.2.1 Projects

This list shows all open projects and their current status. Click on a project to view it in the plot
and editor area. Most actions from the menu and toolbar will apply to the currently shown project.
Each project item can be expanded to show additional information (project type, sample ID, file
path).

Projects can be edited while another project is refining. Multiple projects can be refined at a time,
but refinement may be slow depending on CPU power and number of CPU cores.

Running a batch refinement (see section 2.5) will allow to refine several projects in a sequence,
rather than parallel.

Several projects can be selected with the mouse by holding the Control or Shift keys. Some actions
such as closing, batch refining, results export, etc. will be applied to all selected projects.

Mouse context menu actions are described below:

Start refinement Starts the refinement of the current project.

Close selected projects Closes all selected projects.

Export project data Exports the information shown in the Projects list of all open projects to a
CSV file.

Expand all Expands the sub-items of all open projects.

Collapse all Collapses the sub-items of all open projects.

1.2.2 Plot options

This list shows all scans loaded in the currently shown project. To change the scans’ drawing style
(color, line style, line width), refer to the graph preferences discussed in section 3.3.

If a scan is clicked on with the mouse, it is set to active, as indicated by the symbol ,,A” shown
next to the checkbox. Clicking it again will deactivate the scan. Active scans are shown in bolder
line width than inactive scans. Only one scan can be set to active at a time. The active scan can
be scaled by holding the middle mouse button and moving the mouse vertically. Clicking with
the right mouse button will reset the scale. If a rescaled scan is deactivated, it will not be reset by
a right mouse click anymore, until it is activated again. The only purpose of activating scans is
to visually highlight them and to allow mouse scaling. Currently there is no other functionality
related to scan activation.

Visibility of each scan can be changed by checking or unchecking the box in front of the scan
name. For refined scans Profex distinguishes between main scans (usually Iobs, Icalc, Idi f f , and the
background curve), as well as phase patterns. All phase patterns can be toggled on or off at once
by using the function ,,View→ Show/Hide phase patterns”. This change is persistent and applies
to all open projects. It is a convenience function for easy showing or hiding all phase patterns, but
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the same result can be obtained by manually checking or unchecking all phase patterns of all open
projects.

hkl tick marks are considered as part of phase patterns. Showing/hiding a phase pattern will also
show or hide the phase’s hkl lines. By using the functions in ,,View → Plot” (see section 2.3),
drawing of hkl lines and phase patterns can be controlled separately. This allows to draw either
no phase information, hkl lines only, phase patterns only, or both.

Double-clicking on a scan parameter (name, scale factor, vertical or horizontal offset) allows to
edit the parameter directly. The changes will not be persistent, as they will get lost after closing
the scan file or running a refinement. They will, however, be preserved when exporting the scans
to ASCII, GNUplot, SVG, or PNG format.

Clicking on a scan with the right mouse button will allow to export an individual scan to a differ-
ent file format. See part 2 of the user manual for a list of supported file formats.

Scans can be added or removed to the project by the functions ,,File→ Insert Graph File. . . ” and
,,File → Remove Scan. . . ”. However, as soon as the main graph file is reloaded, for example
automatically during a refinement, and added or removed scans will be reset and only the content
of the reloaded file will be shown.

1.2.3 Refinement protocol

This windows shows the output of the Rietveld refinement backend.

1.2.4 Chemical composition

The ,,Chemical composition” dock window shows the refined chemical composition of the sam-
ple. This information is only available for BGMN, but not for other Rietveld refinement backends.
Part 2 of the user manual explains in more detail how to use the chemical composition table.

Clicking with the right mouse button allows to copy the table to the clipboard. It can be pasted to
a spread sheet program. The semicolon character ,,;” is used as a field separator.

1.2.5 Context Help

This window shows the context help, which can be accessed by placing the mouse cursor on a
keyword in a control file, and pressing ,,F1”. Context help is available for BGMN, but may not be
available for other Rietveld refinement backends (see section 2.10).
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Figure 2: Many elements of the user interface can be re-arranged by grabbing the title bar (1) and
dragging the window to a different place (2 stacked; 3 detached from the main window; 4 closed).
The green rectangle (1) shows the title bar that can be grabbed with the mouse to rearrange the
windows. To attache a floating window to the main window, grab it by the title bar and move it
close to the edge of the main window, until a dock indicator (5) appears.

1.2.6 Convergence Progress

The ,,Convergence Progress” window shows a live graph of Rwp, Rexp, and an acceptance limit
for χ2. Rwp starts at 100 % and converges towards Rexp as the refinement progresses. The χ2

acceptance limits marks the level at which the goodness of fit can be considered acceptable. The
value can be configured in the ,,Limits” page of the preferences dialog. For optimum goodness of
fit Rwp reaches Rexp.

Clicking with the right mouse button allows to toggle the legend visibility, and to export the
graph data to text files or PDF files. Clicking with the left mouse button toggles the y-axis scaling
between full scale (0–100 %) and zoomed in on the latest values (Fig. 3). In unzoomed state the
scroll wheel can be used to zoom vertically into the graph.
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(a) Full-scale y-axis. (b) Zoomed y-axis.

Figure 3: Convergence progress dialog.

1.2.7 Peak integrals

A detailed description of how to use the ,,Peak intergrals” feature is given in part 2 of the user
manual. The ,,Peak integrals” window shows a table with all integrals, starting with the name
of the range in the first column, followed by the start and end angle. These parameters can be
adjusted by changing the values in the table. The ranges can be renamed, and both angles can be
adjusted. The following columns show the integrated intensity of all scans in the project. Depend-
ing on the state of the button ,,Subtract linear background” on the right, the integrated intensity
includes the background or not.

The button ,,Apply ranges to all open projects” adds all defined ranges to all other open projects.
If the other projects had integral ranges, these ranges will be cleared first. A dialog to select the
projects receiving the intgral ranges is shown before applying the ranges.

The button ,,Paste data from clipboard” is a convenient way to define ranges in a spreadsheet
program or in a text editor and apply to Profex. For example to create 5 ranges at specific angles,
use a text editor and enter the ranges in the format ,,Name;Start Angle;End Angle”, separated
either by ; or by a tabulator, and angles be given in ◦2θ:

Range 1;10.00;11.00
Range 2;12.00;12.75
Range 3;25.75;26.25
Range 4;29.50;30.25
Range 5;45.10;45.90

Alternatively, create this list in a spreadsheet program. Then copy the list to the clipboard and
click the button ,,Paste data from clipboard” in Profex. The new ranges will be appended to the
list.
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1.2.8 Peak list

This list shows all peak positions determined by the ,,Peak detection” function. More information
on how to use peak detection is given in part 2 of the user manual. If peak detection is executed
several times, a new hkl dataset will be created and appended to the plot each time. In order to
display the hkl data of a certain dataset in the table, select it from the box ,,hkl list”.

Peaks selected with the mouse will be highlighted in the scan. Selected peaks can be deleted by
clicking ,,Remove selected line”. To clear the selection and highlighting in the graph, click ,,Clear
selection”.

The entire hkl list can be exported to a text file by clicking ,,Save list to CSV file”.

1.2.9 Search-Match

The Search-Match window allows to control the search-match parameters, and it displays the
results of the phase matching. Details on how to use search-match are described in part 2 of the
user manual.

1.2.10 Refined parameters

This windows shows a summary of the refined parameters. The data is extracted from the *.lst
file. In addition to data found in the *.lst file, the fit parameters χ2 and GoF are shown in the
,,Statistics” group.

The values shown in the ,,Global GOALs” and ,,Local GOALs” groups can be configured by the
user. The process is described in Section 3.4.9.

1.3 The Plot Area

The plot area is the central area of the main window. It shows the loaded scans. Some appearance
options can be configured in the preferences dialog as described in section 3.3. Visibilities of the
legend, hkl indices, and phase patterns can globally be switched on or off in the menu ,,View→
Plot”, as described in section 2.

Scans from different graph files can be added to the plot area by the function ,,File→ Insert Graph
File. . . ”. Several files can be selected at a time. To remove a specific scan, select it in the dock
window ,,Plot Options” and click ,,File → Remove scan. . . ”. When starting a refinement, the
project’s main graph file will automatically be reloaded and all added or removed scans will be
reset to the main graph file’s content.

The plot area interacts with mouse and key events. A summary of mouse and keyboard com-
mands can be displayed by pressing the ,,Shift” key or selecting ,,Help → Mouse and keyboard
commands”. The plot area is divided into several segments (Fig. 4): The central data area shows
the scans, hkl indices, and legend. The left margin area showing the y-axis labels. The bottom
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Figure 4: The plot area is divided into several regions interacting with the mouse cursor: 1 central
data area, 2 left margin area, 3 bottom margin area.

margin area shows the x-axis labels. The top margin area shows the file name. The right margin
area is currently unused. The central area, left margin area, and bottom margin area interact in
different ways with the mouse cursor.

1.3.1 Central Data Area

Moving the mouse cursor: The cursor position will be displayed in the status bar at the bottom
of the main window. The horizontal and vertical position will be shown in degrees 2θ and
counts or counts per second, depending on the unit of the y-axis (see section 3). Addition-
ally, the horizontal position will also be shown as d value in Å. The wavelength is used to
calculate d values. If no wavelength information is found in the scan file, Profex will use the
default wavelength specified in the preferences (see section 3).

Hovering the mouse pointer on a hkl index line at the top of the plot will show a tool tip
displaying the phase name, hkl Miller indices, and the texture factor.

Left Mouse Button – Zooming: Use the left mouse button and drag the mouse to zoom into the
plot.

Alternatively use the mouse scroll wheel to zoom horizontally to the location of the mouse
cursor, or hold the Ctrl key and use the scroll wheel to zoom vertically to the location of the
mouse cursor.
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Hold the Ctrl key and left mouse button to move the zoomed scan.

Hold the Shift key and left mouse button to create a peak integral range.

Right Mouse Button – Unzooming: Click the right mouse button in the data area to view the en-
tire scan range.

,,c” Key – Cross hair cursor: Press the ,,c” key on the keyboard to activate a cross hair cursor
(Fig. 5). Press ,,c” again to disable it.

,,n” Key – Counting noise cursor: Press the ,,n” key on the keyboard to show or hide a cursor
indicating a range of

±
√

Intensity[counts]

This range represents the Poisson-distributed statistical counting noise and allows to evalu-
ate mismatches between Iobs and Icalc, for example at the tips of peaks (Fig. 5).

When moving to the difference curve, the noise cursor will show the counting noise at the
intensity of the first scan (e. g. Iobs) at the same 2θ position.

,,s” Key – Spectral line cursor: Press the ,,s” key to show or hide a cursor showing lines at the
position of Kα1, Kα2, and Kβ. The Kα1 line will be drawn at the position of the mouse cursor
(Fig. 5). Positions for Kα2 and Kβ lines will be calculated from the d value at the cursor
position. If no wavelength is available, the default wavelength specified in the preferences
dialog will be used (see section 3). For monochromatic synchrotron radiation this feature is
meaningless. Use the cross hair cursor instead.

Additionally, peaks from characteristic Tungsten radiation (WLα1 and WLβ) can be shown
by activating the option ,,Show characteristic Tungsten lines with spectral line cursor” in
the preferences dialog (section 3). This allows to inspect the diffraction pattern for Tungsten
contamination lines caused by aging X-ray tubes. The relative intensities of Tungsten lines
[4] are WLα1 (100 %), WLβ1 (49.4 %), WLβ2 (20.2 %). WLβ2 is not shown.

,,h” Key – Help dialog Press the ,,h” key to show a tooltip with information on keyboard and
mouse commands.

Double Click – Load reference structure: Double click with left mouse button will load the ref-
erence structure with it’s strongest peak closest to the double click position. This is a very
simplistic way for phase identification, however, it can be very efficient and useful in some
situations. Note that only indexed structure files are considered. Refer to section 1.5 for
more information on indexing of references structure files. Also note that the strongest peak
of the reference structure indices depends on the instrument configuration used for index-
ing (fix or variable divergence slit) and may therefore not be at the location of the currently
processed scan.

Middle Mouse Button – Scale reference lines: Hold the middle mouse button and move the
mouse vertically to scale the intensity of reference lines. Dragging the lines below the line of
zero counts allows comparing peaks in the difference curve.
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Double Click + Ctrl – List of coordinates: Hold the Ctrl key and double click with the left mouse
button to copy the coordinates of the mouse cursor to the refinement output console. From
there the coordinates can be copied and pasted to another program for further processing.

1.3.2 Left Margin Area

Right Mouse Click: Opens the context menu:

Scale Linear: Sets the scaling of the y-axis to linear. The change is only temporary, i. e.
the setting in the preferences dialog is not affected. Other open projects and projects
opened after changing the y-axis scaling will still use the scaling specified in the pref-
erences dialog. To permanently change the scale, it must be changed in the preferences
dialog.

Scale Sqrt: Sets the scaling of the y-axis to
√

counts. The change is volatile (see above).

Scale Log10: Sets the scaling of the y-axis to log10(counts). The change is volatile (see
above).

Zoom to Baseline: Sets the zoom range from the baseline (0 counts for linear and square
root scaling, 1 count for log10 scaling) to the maximum intensity. It essentially hides
the difference curve. This feature is convenient for square root or log10 scales, for which
the difference curve tends to dominate the display.

Zoom to minimum intensity: Sets the zoom range from the minimum intensity found in any
of the scans (except for the difference curve) to the maximum intensity. This is particu-
larly useful for log 10 scaling, which tends to over-represent the white space between 0
and the background.

Reset Y-Axis Zoom: Resets the zoom of the y-axis to show the full angular range. The zoom
state of the horizontal axis is maintained.

1.3.3 Bottom Margin Area

Right Mouse Click: Opens the context menu:

Reset X-Axis Zoom: Resets the zoom of the x-axis to show the full angular range. The zoom
state of the vertical axis is maintained.
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(a)

(b)

(c)

Figure 5: Different cursors of the plot area: (a) counting noise cursor, (b) cross hair cursor, (c)
spectral lines cursor.
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1.3.4 Stacking Scans

All scans in the plot area, originating from a single graph file or combined from several graph files
using ,,File→ Insert Graph File. . . ”, can be stacked vertically and/or horizontally. Offsets can be
adjusted by ,,View→ Increase vertical displacement”, ,,View→ Decrease vertical displacement”,
,,View→ Displace left”, and ,,View→ Displace right”. All displacements can be reset by ,,View
→ Reset Displacement”. An initial offset will be applied, which can be reduced incrementally by
calling the function moving the scans in the opposite direction. The following commands were
used to create the graphs shown in Figs. 6a and 6b:

1. ,,View→ Increase vertical displacement” to stack the scans vertically at regular intervals of
the maximum intensity of the strongest scan (Fig. 6a).

2. ,,View→Decrease vertical displacement” was called several times to reduce – not reset – the
vertical offset, followed by ,,View→ Displace right” to stack the scans to the right (Fig. 6b).

A special vertical offset will be applied when calling ,,View → Decrease vertical displacement”
first. In that case, positive vertical stacking will be applied, but instead of regular intervals, each
scan will be displaced to the maximum intensity of the previous scan (Fig. 6). This will avoid
large gaps above scans with low maximum intensity, however, it can also be confusing with scans
of very low intensity (e. g. amorphous samples or the background curve). In the latter case,
applying a regular stacking interval by calling ,,View→ Increase vertical displacement” may be
preferred.

1.4 Text Editors

Text editors can show any kind of text files, including control files, list files, structure files, or
any generic text file. For control files and list files they will show syntax highlighting for better
representation.

Besides the standard actions for text editors, such as copy, paste, undo, redo, and selection, the
context menu shown by clicking with the right mouse button has some special features for control
and structure files.

1.4.1 Control File specific features

Open File: When placing the cursor on a file name and clicking with the right mouse button, the
context menu will show the action ,,Open File” at the bottom. Depending on the file type,
the file will be opened as a scan file (VAL[n], DIAGRAMM), or as a text file (STRUC[n],
STRUCOUT[n], SimpleSTRUCOUT[n], RESOUT[n], PDBOUT[n], FCFOUT[n]).

Note that if the file name contains spaces or underscores, the full file name must be selected
with the text cursor before right-clicking. Else the file name will not be recognized correctly.
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Add <output> file: When placing the cursor on a STRUC[n] file line and clicking the right mouse
button, the context menu will offer to add various structure output files. The refined crystal
structure will be written to these files at the end of the refinement. They may be useful for
import into other programs, e. g. for structure visualization or publication in databases or
papers. The output file names will be set to <phaseName>-<projectBasename>.ext
so as to create unique file names and prevent accidential overwriting of output files
from other projects in the same directory. The formats offered are STRUCOUT[n],
SimpleSTRUCOUT[n], RESOUT[n], PDBOUT[n], and FCFOUT[n]. Please refer to the
BGMN documentation for more information about the file formats.

1.4.2 Control and Structure File specific features

When placing the cursor on a parameter and clicking with the right mouse button, the context
menu will offer the following actions:

Fix Parameter: This will set the parameter under the mouse cursor to be fixed (i. e. not refined).

Refine Isotropically: This will release the parameter under the mouse cursor for isotropic refine-
ment. Reasonable lower and upper limits will be applied by default.

Refine Anisotropically: This will release the parameter under the mouse cursor for anisotropic
refinement. A reasonable upper limit will be applied by default. Note that if the parameter
cannot be refined anisotropically (e. g. unit cell parameters, fractional coordinates, etc.),
choosing anisotropic refinement will set the parameter to isotropic refinement, but without
any lower and upper limits.

Refinement states of parameters can also be toggled with the keys F5 and F6. If clicked on a pa-
rameter supporting anisotropic refinement, the refinement state will be changed in the following
order:

F5: anisotropic → isotropic with limits → fix

F6: fix → isotropic with limits → anisotropic with upper limit

If the parameter does not support anisotropic refinement, the refinement state will be changed in
this order:

F5: isotropic without limits → isotropic with limits → fix

F6: fix → isotropic with limits → isotropic without limits

Reasonable default limits will be used in all cases. If the toggled parameter is an EPSn parameter
in the control file, the numbering of PARAM[n] will be updated automatically if necessary.
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1.5 Tool bars

All functions shown in the main toolbar, project toolbar, and refinement toolbar are also accessible
in the menu bar and are described in detail in section 2. Toolbars can be re-arranged by dragging
the left end to another position, or shown / hidden by right-clicking on a toolbar and checking or
unchecking the toolbar in the context menu.

Elements of the reference structure toolbar are only visible if at least one project is loaded. They
are not accessible through a menu, only by the toolbar buttons:

Reference structures: A menu allowing to select a reference structure from all STR files found
in the structure database directory. If selected, the STR file’s hkl lines will be shown in the
graph. This is a generic way of phase identification. When using the ,,Add Phase” dialog
while a reference structure is displayed, this structure file will be pre-selected in the ,,Add
Phase” dialog.

If STR files have not been indexed before, hkl indices will be calculated on the fly when the
structure is selected. On modern computers, this only takes a second or two. Afterwards the
hkl positions will be buffered and will be available instantly next time the same structure is
selected. The buffer can be cleared as described in section 3.4.5. Note that the double-click
function described in section 1.3 is only available for indexed reference structures.

The reference structure menu is editable. When clicking on the menu and starting to type
the name of a phase, auto-completion will propose the best matching phase. Press Enter to
accept the proposed phase.

Reset reference structure: This button will reset the reference structure dropdown menu and
hide reference hkl lines. After resetting, no structure will be pre-selected in the ,,Add Phase”
dialog anymore.

Search and index new reference structures: Pressing this button will scan the structure database
directory for new STR files and index all new files. The reference structures become imme-
diately available in all projects.

Favorites: If clicked, only the phases flagged as favorite will be displayed in the dropdown menu.
Important: Double-clicking on a peak in the graph to select the nearest reference structure
will only search among the favorite structures if this button is clicked.

Height displacement of the sample surface and misaligned detectors cause a shift of the measured
reflections in 2θ. This may cause confusion, because the peak positions and d values differ from
the true value and hkl reference lines. Phase identification would become more difficult as double-
clicking on the strongest peak would load a wrong reference structure. Sample height errors can
be corrected using the spin box and buttons in the reference structure toolbar as described below
(Fig. 7).

Spin box EPS2: Changing the value from 0.0 to a positive or negative value will shift hkl lines and
the mouse cursor coordinates accordingly. The spin box shows the BGMN variable EPS2 in
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(a) (b) (c)

Figure 7: Sample height displacement results in a shift of the peaks in 2θ. The reference peaks no
longer match the shifted measured peaks (a). Manually correcting for the shift aligns the reference
peaks (b). After refinement, the refined shift is automatically applied (c).

radians. The effective sample height displacement ∆ can be calculated from EPS2 and the
instrument radius R as follows:

∆ =
R · EPS2

2
∆ and R have the same unit, e. g. millimeters. After a successful refinement, the correct
refined value for EPS2 will be applied automatically in order to center hkl tick marks and
reference lines on the peaks. Internally Profex also reads the refined values for zero-offset
(EPS1) and penetration depth (EPS3) and applies the corresponding angular corrections.
But in contrast to EPS2 these values cannot be controlled by the user.

Button ,,Set angular corrections to refined values”: Pressing this button will reset all angular
corrections (EPS1, EPS2, EPS3) to the refined values read from the refinement results file
(*.lst).

Button ,,Set angular corrections to zero”: Pressing this button will reset all angular corrections
(EPS1, EPS2, EPS3) to 0.0.
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2 Menu Structure

2.1 File

Open Text File. . . (Ctrl+O) Opens a file in a text editor. If a project with the same name as the
text file’s base name is already open, the file is opened in this project. Else a new project is
created.

If the text file is a control or results file, Profex will automatically locate all other control and
results files of the same project, as well as the scan file, and open them, too. Non-existing
files are ignored.

BGMN structure files (*.str) are always opened in the currently shown project, regardless of
the project name.

Open Raw Scan File. . . (Ctrl+G) Opens a scan file in a new project. If a control and/or results file
with the same base name is found, Profex will open it, too. The file dialog will only show
file format filters for raw data files.

Open Refinement Project. . . (Ctrl+R) Opens a previously created refinement project. The file dia-
log will only show file format filters for refinement output files.

Open Project Archive A project backup created with ,,Project→ Save Project backup” can be ex-
tracted and opened. The archive will be extracted in a sub-folder named after the archive
file.

Insert Scans. . . (Ctrl+I) Inserts scans from one or more graph files into an existing project. The
additional scans will only be displayed in the project’s graph view. Other files, such as
the control file, will not be modified. If no project is available, a new one will be created,
based on the name of the first selected graph file. Inserted scans will be discarded when the
project’s graph file is reloaded, e. g. during a refinement.

Remove Scan. . . Removes the scan selected in the ,,Plot Options” window from the graph view.
No other files will be modified. Removed scans will be restored when the project’s graph
file is reloaded, e. g. during a refinement.

Save (Ctrl+S) Saves the current file under the same file name. This function only works for text
files.

Save file as. . . (Shift+Ctrl+S) Saves the current file under a new file name. A file dialog is shown
to ask for the file name, location, and file format.

Save all text files in all projects (Ctrl+Alt+S) Saves all modified text files (control and structure
files) in all open projects. This function can be used after calling ,,Edit→ Copy control file”,
because the newly created control files will only be created in text editors, but not yet saved
to disk. Calling this function will save them to disk all at once.

Recent Graph Files Shows a list of recently opened graph files.
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Recent Text Files Shows a list of recently opened text files. For scan files, different output formats
can be selected. Scans can be saved as raw data for further processing, or images.

Print (Ctrl+P) Prints the currently shown text or graph file. Printing options may differ depending
on the platform and device driver.

Print all Graphs (Shift+Ctrl+P) Prints the graphs of several open projects at once. A project selec-
tion dialog will be shown first. By default all open projects are selected. If the graphs are
printed to a PDF file, one file containing all graphs will be created.

Export all Graphs to SVG Creates SVG (vector graphics) files of several projects. A project selec-
tion dialog will be shown first. By default all open projects are selected. Each graph will be
saved to an individual SVG file.

Close Project (Ctrl+W) Closes the current project. If a refinement is running, a message will ask
for confirmation before aborting the refinement.

Close All Projects Closes all open projects. If one or more refinements are in progress, a warning
will be displayed and no project will be closed.

Import Structure File. . . Opens a dialog to convert CIF files (*.cif) or ICDD XML files (*.xml) to
BGMN structure files (*.str). See part 2 of the user manual for more information on how to
export CIF files. CIF files can be obtained from various databases. ICDD XML files can be
exported from the ICDD PDF-4+ graphical user interface using ,,Save PDF card as. . . ”.

Scan Batch Conversion. . . Opens a dialog for batch conversion of graph files. All currently
opened project scans will be added to the batch list by default. More files can be added
or deleted in the dialog. More details on how to use batch conversion are given in part 2 of
the user manual.

Scan batch refinement script. . . This function creates a script file to run a list of refinements out-
side of Profex. This is useful to refine a large number of files on a remote system, for example
on a high-performance cluster. Supported output formats are Bash scripts for unix systems
(Linux, Mac OS X) and Windows CMD files.

Quit (Ctrl+Q) Quits the application.

2.2 Edit

Undo (Ctrl+Z) Reverts the last change in the currently shown text file.

Redo (Shift+Ctrl+Z) Restores the last undone change in the currently shown text file.

Cut (Ctrl+X) Cuts the selected text and keeps it in the clipboard. This action only works on text
editors, it has no effect on the graph display.

Copy (Ctrl+C) Copies the selected text to the clipboard. On graph displays a pixel image of the
graph is copied to the clipboard. The resolution can be specified in the preferences (sec-
tion 3.3.4).
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Paste (Ctrl+V) Pastes the content of the clipboard. This action only works on text editors, it has
no effect on the graph display.

Copy Control File Copies the current project’s control file to other projects and adapts all input
and output file names to match the projects’ base names. A dialog will allow to select which
projects’ control file shall be modified. Existing control files will be overwritten.

Note that this function does not check whether referenced structure files are actually present
in all project directories. It only manages control files, but not structure files.

Insert Text Block Inserts the selected pre-defined text block to the current text editor at the cur-
sor’s position. If a graph is shown, this action will do nothing. Text blocks can be configured
in the preferences dialog.

Reset File Reverts the current project’s control file to the state before the last refinement. This
function is only used for the Fullprof.2k backend, but not for BGMN, because BGMN usually
does not modify STR and SAV files.

Find and Replace. . . (Ctrl+F) Searches a string in a control or structure file, and replaces it. If
,,use Regular Expression” is checked, the ,,Find” keyword will be interpreted as a regular
expression pattern.

Preferences. . . Opens the program’s preferences dialog. All preference options are discussed in
detail in section 3.

2.3 View

Set Zoom Range. . . Opens a dialog to zoom the graph to precise upper and lower limits for angle
and intensity. After closing the range dialog, a project selection dialog is shown to apply the
zoom range to multiple projects.

Reset Zoom Range. . . Resets the zoom range. A project selection dialog is shown to reset multi-
ple projects at a time.

Reset margin color Resets the color of the graph margin to idle color. This is useful for taking
screenshots after completed refinements.

Show/Hide Phase Patterns (Ctrl+0) Activates or deactivates visibility of all phases. This option
applies to all open projects. It only checks or unchecks the visibility boxes of all phase pat-
terns in the Plot Options list for convenient displaying or hiding of all phases. Individual
phases can be shown or hidden by selecting or un-selecting the ,,show” option in the Plot
Options list. More information is given in section 1.2.2.

Plot Configure the visibility of the following elements on the plot:

Phase Patterns Shows or hides patterns of phases.

Legend Shows or hides the plot legend.

hkl Indices Shows or hides the hkl index tick marks at the top of the plots.
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Increase Vertical Displacement (Ctrl+Up) Applies a regular vertical offset to all scans. The initial
offset will correspond to the maximum intensity of the strongest scan. When called again,
this function will increase the previous offset by a constant value.

Decrease Vertical Displacement (Ctrl+Down) Reduces the vertical offset of all scans by a constant
value. If no vertical offset exists, an initial adaptive offset will be applied, with a vertical
displacement of each scan corresponding to the maximum intensity of the scan below.

Displace left (Ctrl+Left) If no horizontal offset exists, it will apply a horizontal offset to the left to
all scans. If an offset to the left exists, the offset will be increased by a constant value. If an
offset to the right exists, the offset will be reduced by a constant value.

Displace right (Ctrl+Right) If no horizontal offset exists, it will apply a horizontal offset to the
right to all scans. If an offset to the right exists, the offset will be increased by a constant
value. If an offset to the left exists, the offset will be reduced by a constant value.

Reset Displacement (Ctrl+Space) Resets all horizontal and vertical offsets.

2.4 Project

Add / Remove Phase. . . (F8) Opens a dialog to create or manage a control file. New phases can
be added or existing phases can be removed from the refinement. If no control file exists
yet, a new one will be created. In that case, the correct instrument configuration file must be
selected. The option to create a default control file is automatically activated or deactivated,
depending on whether or not a control file already exists.

If a phase is activated in the Reference Phase box, it will be pre-selected in the Add Phase
list.

If a default control file is created despite an existing control file, the existing one will be
overwritten, any previously added modifications or phases will be lost.

Selected structure files and instrument configuration files will be copied from the structure
and device database directory to the project directory. Files already existing in the destina-
tion directory will be skipped. If the option ,,overwrite existing files” is checked, existing
structure files will be overwritten with the file copied from the structure file database. A
detailed description of the structure file handling is given in part 2 of the user manual and
in section5.1.

When removing a phase from the control file, the structure file can optionally be deleted.
Deleting structure files may cause problems with other projects stored in the same directory
and accessing the same structure files.

Add amorphous peak A special structure file is added to the current project with just one wide
peak modelling the bump caused by amorphous phases. The center position of the peak
can be entered in a dialog. Note that this amorphous phase cannot be used to quantify the
amorphous content, it only improves the refinement of the background curve.
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Open all project STR files (Ctrl+F8) Opens all BGMN structure files (*.str) referenced in the cur-
rent project’s control file (*.sav) in new pages.

Close all project STR files (Ctrl+F7) Closes all BGMN structure files (*.str) shown in the current
project.

Edit all project STR files Opens a dialog allowing to modify the refinement state of all (or a selec-
tion of) STR files used in the current project.

Set Internal Standard Allows to define one refined phase as internal standard phase with a given
quantity. The calculation of phase quantities will be changed to apply the internal standard
correction, and the standard phase will no longer be shown in the summary table.

Unset Internal Standard Reverts the internal standard calculation of refined phase quantities. All
phases will be shown in the summary table in quantities normalized to the sum of all phases.

Refinement Presets Lists all refinement presets to create refinement control files. Select one of
them to apply the preset to the current project. More information on refinement presets is
given in part 2 of the user manual.

Save as Refinement Preset. . . Creates a new refinement preset from the currently loaded project.
More information on refinement presets is given in part 2 of the user manual.

Save Project Backup (Ctrl+B) Creates a ZIP compressed archive of the current project. The file
name is determined automatically as projectBasename-YYYYMMDD-hhmm.zip. It will
be stored inside the current project’s working directory. The archive includes the raw data
file, all instrument files, structure files, and output files of the project.

Save Project Backup As. . . (Ctrl+Shift+B) Creates a ZIP compressed archive of the current
project. The file name and path can be selected by the user. The archive includes the
raw data file, all instrument files, structure files, and output files of the project. The ZIP
archives can be stored as a backup or shared with other users, as they contain all project
relevant data.

Open File Manager (F4) Opens a file manager at the current project’s location.

2.5 Run

Run Search-Match Runs the phase searching and matching process. The process can be config-
ured in the ,,Search/Match phases” window (Window→ Search/Match phases). A detailed
description on how to use search-match is given in part 2 of the user manual.

Run Refinement (F9) Starts the refinement of the currently shown project.

Run Batch Refinement (F10) Starts a batch refinement of several open projects. A project selec-
tion dialog will be shown first to select all or a selection of projects to be scheduled. If this
function is called while a batch is already running, all selected projects will be scheduled
and appended to the running batch.
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Abort Current Refinement (Shift+F9) Aborts refinement of the currently shown project. In batch
refinement mode all projects scheduled for batch refinement will be unscheduled. If the cur-
rently shown project is not running but scheduled, it will be unscheduled but the remaining
batch refinement will not be interrupted. In either case refinements started outside of the
batch will not be interrupted.

Abort All Refinemet (Shift+F10) Aborts all running projects and batches. If more projects than the
currently shown one are affected, the user will be asked for confirmation.

Run peak detection Starts the peak detection process using EFLECH. Results are displayed in
the window ,,Peak List” (Window→ Peak List). A detailed description of peak detection is
given in part 2 of the user manual.

Follow Active Refinement When processing a batch refinement, activate this function to always
raise the currently refining project. If a project refinement has completed, the next scheduled
project will automatically be raised. This allows to monitor the batch refinement on screen.
The function can be toggled on and off at any time, also during a running batch. It is au-
tomatically deactivated as soon as the user selects a text editor of any open project, so as to
avoid automatically raising a different project while a text file is being edited or read.

2.6 Results

Export Global Parameters and GOALs (Ctrl+E) Exports the global parameters and goals (e. g.
phase quantities) to a semicolon separated spread sheet (*.csv). Part 2 of the user manual
provides more information on results export.

Export Local Parameters and GOALs (Shift+Ctrl+E) Exports the local parameters and goals (e. g.
structural parameters) to a semicolon separated spread sheet (*.csv). Part 2 of the user man-
ual provides more information on results export.

Export refined chemical composition. . . Writes the calculated chemical composition to a semi-
colon separated spread sheet (*.csv). Part 2 of the user manual provides more information
on results export.

Export Peak Integrals Exports all peak integral data to a semicolon separated spread sheet (*.csv).
Part 2 of the user manual provides more information on results export.

Export CIF file from LST file This function reads LST files of all open projects and writes crystal
structure information to CIF files. One CIF file will be created for each crystal structure
found. The file will be stored in the project directory. Information on saved files is shown
in the refinement protocol console. Part 2 of the user manual provides more information on
results export.

Export CELL file from RES file This function reads RES files of all open projects and writes crystal
structure information to CELL files for the software Castep [5]. One CELL file will be created
for each crystal structure found. The file will be stored in the project directory. Information
on saved files is shown in the refinement protocol console. If no RES file is available for a
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specific phase, a tag RESOUT[n]=filename.res must be added to the control file (*.sav)
and the refinement must be repeated.

Generate report A report of the current refinement results is generated. The resulting HTML file
can be viewed in a web browser and printed from there. Part 2 of the user manual provides
more information on creating refinement reports.

2.7 Instrument

New Configuration. . . Read some hardware information from Bruker RAW V4, Bruker BRML V5,
and PANalytical XRDML files to create a BGMN instrument configuration file from scratch.
Other raw data formats are not supported. Usually several variables required by BGMN
will not be available from the raw data files and will thus have to be entered manually. See
part 2 of the user manual for more information on creating instrument configuration files.
This feature is experimental.

Edit Configuration. . . Opens a dialog to process BGMN instrument configurations. See part 2 of
the user manual for more information on creating instrument configuration files.

Edit Current Configuration. . . Opens the instrument configuration file used in the current project
in an editor. If the configuration file (*.sav) is not found in the current project directory, the
file will be searched in the devices repository. If found, a copy will be created in the project
directory and opened in the dialog.

Show Peak Shape. . . Opens a dialog that calculates the theoretical peak shapes for a selected
instrument configuration file.

2.8 Tools

Browse BGMN Space Groups. . . Opens a dialog to browse space groups and atomic positions
supported by BGMN. The dialog reads the file SPACEGRP.DAT, which is part of the BGMN
software distribution.

Browse Atomic Scattering Factors. . . Opens a dialog to browse atomic scattering (form) factors
supported by BGMN. The dialog reads the file AFAPARM.DAT, which is part of the BGMN
software distribution.

Calculate Absorption Coefficients A dialog opens that allows to calculate linear and mass ab-
sorption coefficients for phases and samples. If a refinement project is loaded, the dialog
will use the refined phases to compute absorption coefficients for each phase based on its
chemical composition, and for the sample based on the phase quantities. However, phases
can also be manually added and removed in order to compute absorption coefficients for
arbitrary compositions.

Process DIA files (coming soon)
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Scan Math The tool ,,Scan Math” allows to perform calculations on the intensities of all scans
loaded in a project. Expressions must be entered in Java Script syntax [6, 7]. A detailed
description of the Scan Math dialog is given in part 2 of the user manual.

Add Baseline. . . Opens a dialog to calculate a baseline (background curve) for a certain scan in
the project. Part 2 of the user manual provides more information on baselines.

Electron density maps Opens a dialog to compute electron density maps from *.fcf and *.res out-
put files. See part 2 of the user manual for more information on electron density maps.

Index Reference Structures Searches the structure file repository and indexes new structure files.
Entries of files no longer found in the repository are removed from the database.

2.9 Window

Projects Shows or hides the Projects list window.

Plot Options Shows or hides the Plot Options window.

Refinement Protocol Shows or hides the Refinement Protocol window.

Global Parameters and GOALs Shows or hides the summary table window for global parameters
and goals.

Local Parameters Shows or hides the summary table window for local parameters and goals.

Chemical composition Shows or hides the table showing the refined chemical composition in
oxide form.

Context Help Shows or hides the context help display.

Convergence Progress Shows or hides the window showing a graph with Rwp and Rexp values
during a refinement.

Peak Integrals Shows or hides the peak integral window.

2.10 Help

Context Help. . . (F1) Shows the context help of the keyword under the text cursor. The ,,Context
Help” window (,,View” menu) must be shown to display the context help.

BGMN Variables. . . Opens a web browser showing the BGMN variables documentation page.

Mouse and Keyboard Commands Shows a dialog with mouse and keyboard commands for plot
windows.
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About Profex. . . Shows information about Profex. The button ,,Copy system information to clip-
board” copies the system information as well as the content of the log file to the clipboard. It
can be pasted in text format to other programs. This information can be helpful for support
requests. All information is encoded in plain text. Users are requested to carefully review
the content and delete any critical personal or technical information prior to sharing the
information with the Profex developers.
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3 Preferences

3.1 General

Icon theme Select the icons used by Profex. Three options are availble:

Light: A plain monochrome icon set to be used with a light desktop theme.

Light color: A bi-color icon set to be used with a light desktop theme.

Dark: A plain monochrome icon set to be used with a dark desktop theme.

Toolbar Layout Select how icons and text in Profex’ toolbars are shown. ,,Follow Style” will match
the system-wide style used by the operating system.

Restore open projects If checked, Profex will load all previously open graph files upon program
start. If unchecked, Profex will not load any projects or files at program start.

Default Project Type For file formats not specific for either BGMN or Fullprof.2k, this option de-
termines which type of project will be created when such a file is opened. The file type is
identified by the file extension.

File extensions can also be associated with either of the two backends by adding the ex-
tension either to the list of ,,File Extensions associated with BGMN” or ,,File Extensions
associated with Fullprof”.

Number of CPU cores used by BGMN Specifies how many CPU cores will be used by the refine-
ment backend (only available for BGMN). ,,Automatic” will use all available cores.

File Extensions associated with Fullprof These file types will always be opened as Fullprof
projects, regardless of the default project type. Enter the extension in small letters without
asterisks and periods, separated by a space character. Example: pcr dat sum prf

File Extensions associated with BGMN These file types will always be opened as BGMN
projects, regardless of the default project type. Enter the extension in small letters without
asterisks and periods, separated by a space character. Example: sav lst dia str

Default Wavelength This wavelength, given in Å, is used for scan files not containing any infor-
mation about the wavelength.

Always use default Wavelength If checked, Profex will ignore the wavelength read from the scan
file and always use the default wavelength to calculate d values from diffraction angles. Use
this option with care. Any wavelength information read from raw data files will be ignored
if this option is checked.
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3.2 Text Editors

Font Sets the font of the text editor and refinement protocol window.

Syntax highlighting Select the color set used for syntax highlighting by the text editors. Four
options are available:

Automatic: Selects an appropriate theme for light and dark desktop themes.

Light mode: Selects a highlighting theme with dark colors that are easily readable on a light
background.

Dark mode: Selects a highlighting theme with light colors that are easily readable on a dark
background.

Off: Turns syntax highlighting off. The font is black on light desktop themes, and white on
dark themes.

3.3 Graphs

3.3.1 Appearance

Use AntiAliasing for Graphs (slow!) Uses anti aliasing to draw the plots. If checked, lines look
smoother but also wider. Drawing will be slower if checked.

Show characteristic Tungsten lines with spectral line cursor When using the spectral line cursor
(1.3), additional lines will be shown for characteristic Tungsten radiation (WLα1 and WLβ1).
This allows to inspect the diffraction pattern for Tungsten contamination lines caused by
aging X-ray tubes.

Show major grid lines Show or hide vertical and horizontal grid lines at the positions of major
tick marks. Major grid lines will be drawn as medium dashed lines.

Show minor grid lines Show or hide vertical and horizontal grid lines at the positions of minor
tick marks. Minor grid lines will be drawn as light dotted lines.

Show complete file name If checked, the file name of the graph file will be shown with the ab-
solute path in the top right corner of the graph display. If unchecked, only the file name
without file path will be shown.

Display Line Width Width in pixels of all lines (plots, axes, tick marks) of the graph on computer
screens. If plot lines are too fine (e. g. on high-resolution displays) increase this value.

Symbol Size Size of the measured data points when not using solid lines (e. g. dots or crosses) in
pixels.

Y-axis Scaling Scaling of the y-axis. Options are linear, logarithmic with a base of 10 (log10), or
square root (sqrt).
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Y-axis unit Shows the y-axis unit either in counts, or in counts per second (cps). Counts per
second may not be available, depending on the file format of the loaded scan. If the time per
step is not available, Profex will fall back to the unit ,,Counts” and assume a counting time
of 1 second per step.

Only the display of scans will be affected by the choice of the unit. Internally, all calcula-
tions and file format conversions will be performed in ,,Counts”. As a consequence, when
converting a format supporting ,,Counts per second” (such as XRDML) to a format not sup-
porting it (such as ASCII XY), the displayed unit may change from [cps] to [counts].

Multi-Scan Files Select whether multi-range files will be shown as individual scans, as the sum
of all ranges, or as the average of all ranges.

Create Thumbnail If checked, a thumbnail picture of the refined plot will be created at
the end of the refinement. This file is stored in the project directory with the name
project-basename tn.png. It allows easy browsing of refined projects. The width
of the picture can be specified in pixels. The height is calculated from the displayed aspect
ratio.

Use margin colors If activated, the margin of the graph will change color to indicate the refine-
ment status. By default, the color for idle projects is white, for refining (active) projects red,
and for completed projects green. The colors can be customized.

Idle Select the color of the graph’s margin in idle state. Usually white is the preferred option.

Active Select the color of the graph’s margin in active state (during refinements). The default is
light red. If no color change is preferred, select the same color as for idle state.

Complete Select the color of the graph’s margin in complete state (after convergence of refine-
ments). The default is light green. If no color change is preferred, select the same color as for
idle state. The margin color can be set back to idle color by clicking ,,View→ Reset margin
color”.

3.3.2 Fonts

Font Title Select the font of the file name at the top-right of the graph.

Font Axis Labels Select the font of the graph axis labels.

Font Tick Marks Select the font of the graph tick marks.

Font Legend Select the font of the graph legend.
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Figure 8: Randomly generated scan colors (left) used for multi-scan files. Standardized colors for
refined projects (right).

3.3.3 Scan Styles

Color Customize the list of colors to be used to draw scans by double-clicking on the color cell. If
more scans are loaded than colors are available from the list, a random color will be created
and added to the list. The first color defaults to black, all following colors are randomly
generated. They can be changed manually later on. Line widths can be changed on the
Graph’s Appearance page.

Point Style Select the style to draw scans. ,,Solid” draws the scan as a solid line. ,,Points” draws a
dot at the measured position, ,,Cross” draws a cross at the measured position. Symbol sizes
of crosses and points can be changed on the Graph’s General Appearance page.

+ Add another color to the color list.

− Remove the currently selected color from the list.

Standard colors Multiple scans can be loaded either from a raw data file containing more than
one scan, or from a refined project containing one raw data scan (Iobs), as well as several
calculated scans (Icalc, Idiff, background). Multi-scan files use the colors specified in the
color list above. However, separate colors can be used for refined projects. These standard
colors override the colors in the list above as soon as Profex detects a refined project. This
is helpful to use pretty colors for multi-scan files, but the defacto standardized colors for
Iobs (black), Icalc (red), Idifference (grey), and background (blue). An example for the two
different modes is shown in Fig. 8.

3.3.4 Print and Export

Print: Line Width Width in points of all lines (plots, axes, tick marks) of the graph on printouts.
This value should usually be greater than the display line width. It has to be matched to the
printer device driver by printing test plots.
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Print: Font Scale Factor The font size on printouts can be scaled. Use values greater than 1.0 if
the font is too small, and smaller than 1.0 if the font size is too large. The value has to be
matched to the printer device driver by printing test plots.

ASCII Data Export: Field Separator Enter the field separator used when exporting data to ASCII
text files. Only non-alphanumeric characters are allowed. Common choices are the semi-
colon (;), comma (,), space ( ), or tab.

Raster Export: Width Width of the exported image in pixels.

Raster Export: Height Height of the exported image in pixels.

SVG Export: Font Scale Factor Adjusts the font scale on SVG graphs. Increase the value if the
font is too small, or decrease if the font is to large.

3.4 BGMN

3.4.1 Backend Configuration

BGMN executable Selects the BGMN executable file. This file is part of the BGMN installation. It
is called BGMN.EXE on Windows, and bgmn on Mac OS X and Linux.

MakeGEQ executable Selects the MakeGEQ executable file. This file is part of the BGMN instal-
lation. It is called MakeGEQ.EXE on Windows, and makegeq on Mac OS X and Linux.

Geomet executable Selects the Geomet executable file. This file is part of the BGMN installation.
It is called GEOMET.EXE on Windows, and geomet on Mac OS X and Linux.

Teil executable Selects the Teil executable file. This file is part of the BGMN installation. It is
called TEIL.EXE on Windows, and teil on Mac OS X and Linux.

Eflech executable Selects the Eflech executable file. This file is part of the BGMN installation. It
is called EFLECH.EXE on Windows, and eflech on Mac OS X and Linux.

Convert raw scans to XY format If checked, raw scan files will be converted to ASCII XY free
format (*.xy) prior to starting the refinement.

This option must only be disabled if the raw file format is directly supported by the BGMN
backend (e. g. *.val, *.rd).

Spectral line cursor shows all wavelengths from BGMN *.lam file By default Profex uses a hard-
coded table of characteristic wavelengths to display the spectral lines of Kα1, Kα2, and Kβ

with the spectral line cursor. The primary wavelength is read from the scan file (raw data file
or refined profile), and all related secondary wavelengths are found in the hard-coded table.
If this option is checked, Profex will try to locate the *.lam file specified in the BGMN refine-
ment control file using the keyword LAMBDA=, and read all wavelengths specified there.

The radiation spectrum in the *.lam file is often modeled by overlapping Lorentzian curves.
It is therefore not unusual to use 4 or more emission lines with slightly different wavelength,
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widths, and intensities to model Kα1 and Kα2 with realistic emission line profiles. If addition-
ally Kα3 satellites and Kβ are modeled, even more emission lines are required. The emission
spectrum described in the *.lam file can therefore be relatively complex, and displaying all
lines with the spectral line cursor can lead to a cluttered plot display. For most users using
conventional X-ray tubes with characteristic radiation spectra, with or without Kβ filters or
monochromators, leaving this option unchecked is recommended.

If the *.lam file was not specified, cannot be found, or cannot be parsed, Profex falls back
to the internal hard-coded table of characteristic wavelengths, just as if this option was
unchecked.

Any comment trailing the emission line parameters will be used to label the line. For exam-
ple, to add line labels to the file ,,cu bergmann83.lam”, which is part of the Profex-BGMN-
Bundle distribution:

% Cu-K-alpha doublet as measured in october 1983 by J. Bergmann
ILAM=4 TITEL=CU_vom_Oktober_1983
0.401939 6.49098 0.0010981
0.266445 6.49013 0.0019875
0.167844 6.47504 0.0012544
0.163773 6.47400 0.0017246

add comments to each data line:

% Cu-K-alpha doublet as measured in october 1983 by J. Bergmann
ILAM=4 TITEL=CU_vom_Oktober_1983
0.401939 6.49098 0.0010981 % CuKa1 (1)
0.266445 6.49013 0.0019875 % CuKa1 (2)
0.167844 6.47504 0.0012544 % CuKa2 (1)
0.163773 6.47400 0.0017246 % CuKa2 (2)

Now the emission lines will be labelled as ,,CuKa1 (1)”, ,,CuKa1 (2)” etc. when activating
the spectral line cursor. *.lam files with parametrized intensities are also supported, as for
example the default ,,cu.lam” file distributed with the Profex-BGMN-Bundle package:

% Berger CuK1,2,3 + Kb XPERT BERN
ILAM=6
0.01586*ifthenelse(ifdef(alpha3ratio),(alpha3ratio)/0.01586,1) 6.51571 0.00783 % CaKa3
0.56768*ifthenelse(ifdef(alpha2ratio),(1-alpha2ratio)/0.64369,1) 6.49099 0.00092 % CuKa1 (1)
0.07601*ifthenelse(ifdef(alpha2ratio),(1-alpha2ratio)/0.64369,1) 6.48905 0.00126 % CuKa1 (2)
0.25107*ifthenelse(ifdef(alpha2ratio),(alpha2ratio)/0.35631,1) 6.47496 0.00109 % CuKa2 (1)
0.08688*ifthenelse(ifdef(alpha2ratio),(alpha2ratio)/0.35631,1) 6.47366 0.00130 % CuKa2 (2)
0.00249*ifthenelse(ifdef(betaratio),(betaratio)/0.00249,1) 7.18206 0.00151 % CuKb

Normalize quantity goals to 100 % Normally quantity goals are normalized to 1.0:

sum=betaTCP+betaCPP
GOAL[1]=betaTCP/sum
GOAL[2]=betaCPP/sum

If this option is checked, the goals will be normalized to 100 %:
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sum=betaTCP+betaCPP
GOAL[1]=100*betaTCP/sum
GOAL[2]=100*betaCPP/sum

Create report after refinement If checked, a refinement report in HTML format will be created
automatically after the refinement. The report can be customized as shown in part 2 of the
user manual, and viewed in a web browser.

3.4.2 Repositories

Device Files Directory Specifies the location where BGMN instrument files (*.sav, *.ger, *.geq,
*.tpl) are stored.

Presets Directory Specifies the location where refinement preset files (*.pfp) are stored.

Structure Files Directory Specifies the location where BGMN structure files (*.str) are stored. Sev-
eral directories can be entered. Sub-directories will be scanned for *.str files automatically.
Double or redundant entries will be ignored.

3.4.3 Peak detection

Search for new peaks If checked, the detection process is allowed to add new peaks to the list.
This option should always be activated.

Eliminate obsolete peaks Allows the process to remove peaks from the list if they become obso-
lete later in the peak search.

Allow RP=2 Allows the process to use profile function RP=2 (no peak broadening).

Allow RP=3 Allows the process to use profile function RP=3 (Lorentzian broadening B1 only).

Allow RP=4 Allows the process to use profile function RP=4 (Lorentzian broadening B1 and
squared Lorentzian broadening B2).

Allow increment of profile function If checked, the process is allowed to automatically step the
profile function up to RP=3 or RP=4 if peak broadening is detected.

Allow reduction of profile function If checked, the process is allowed to automatically step the
profile function down to RP=3 or RP=2 if no peak broadening is detected.

Simplify background Search for a simplified background polynome during the fit.
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3.4.4 Search-Match

Penalty Weighing Coefficients

Unit Cell (a) A value > 1.0 increases the penalty for phases with mismatching unit cell parame-
ters. A value of 0.0 disables the penalty function for unit cell mismatches. The default value
of 1.0 applies a moderate penalty.

Weight Fraction (b) A value > 1.0 increases the weight of GEWICHT in the computation of the
figure of merit. A value of 0.0 disables GEWICHT from the computation of the figure of
merit. The default value of 1.0 applies a moderate weight to GEWICHT.

Crystallite Size (c) A value > 1.0 increases the penalty for phases with small crystallite sizes. A
value of 0.0 disables the penalty function for small crystallite sizes. The default value of 1.0
applies a moderate penalty. This parameter only takes effect if the refined B1 value is greater
than the penalty threshold for B1.

Micro-strain (d) A value > 1.0 increases the penalty for phases with micro-strain. A value of 0.0
disables the penalty function for micro-strain. The default value of 1.0 applies a moderate
penalty. This parameter only takes effect if the refined k2 value is greater than the penalty
threshold for k2.

Penalty Thresholds

Crystallite size (B1) The penalty function for small crystallite sizes only takes effect if the refined
B1 value exceeds the threshold specified here.

Micro-strain (k2) The penalty function for micro-strain only takes effect if the refined k2 value
exceeds the threshold specified here.

Duplicates

Unit cell axes (nm) Specifies the range in which unit cell parameters are considered to be equiv-
alent. Phases with unit cell parameters differing less than the range specified here are con-
sidered duplicates.

Unit cell angles (◦) Specifies the range in which unit cell angles are considered to be equivalent.
Phases with unit cell angles differing less than the range specified here are considered du-
plicates.
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3.4.5 Reference Structures

Automatically select best matching reference phase When opening a graph file, automatically
search and select the reference phase with it’s strongest peak at the position of the scan’s
highest intensity. This is the same as double clicking at the strongest peak just after loading
the scan file. Note that only indexed reference structures will be considered.

Automatically index new structure files If checked, Profex will scan the structure file directory
for new structure files each time Profex is started and the first project is loaded.

If not checked, new structures will only be indexed when ,,Tools → Index structure
database” is clicked manually.

Structures will not be available for double-click phase identification as long as they have not
been indexed.

Draw hkl reference lines from background curve if available If this option is checked, Profex will
use a scan with name ,,background” to draw the base of the hkl reference lines on. If no such
scan is found or this option is unchecked, the hkl lines will be drawn from the zero line.

Color of Reference hkl Lines Color of the hkl lines when selecting a reference structure from the
Reference Structures box.

Clear hkl index buffer Clears the buffer file with structure file hkl indices. Profex must be
restarted for this to take effect. All structure files will be re-indexed either automatically,
or when selected from the Reference Structures box.

hkl reference line range Specifies the upper 2θ angle for hkl indices to be calculated. Larger
ranges will require more time to index. The range may be smaller or larger than scan file
ranges.

3.4.6 Favorites

Select reference structure files to be shown in the ,,Add / Remove Phase” and the reference struc-
ture dropdown menu when the ,,Favorites” filter is applied.

3.4.7 Refinement Limits

On this page the upper and lower limits automatically added by Profex to refined parameters are
specified. These limits are used when creating BGMN structure files (*.str) from CIF or ICDD XML
structure files, or when toggling the refinement state of parameters.

Unit Cell Parameters Specifies the upper and lower limits of unit cell parameters. The value is a
fraction of the unit cell parameter specified in %. It is therefore independent of the setting of
UNIT.
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Fractional Coordinates Upper and lower limits of fractional coordinates released for refinement.
The unit of this value is in fractional coordinates and thus independent of the parameter
UNIT. Example: Releasing the coordinates of the following atom for refinement with a limit
of 0.05:

E=SI Wyckoff=f x=0.25 y=0.5 z=0.1234 TDS=0.02

will result in (without line break):

E=SI Wyckoff=f PARAM=x=0.25_0.20ˆ0.30 PARAM=y=0.5_0.45ˆ0.55
PARAM=z=0.1234_0.0734ˆ0.1734 TDS=0.02

B1 Specifies the upper limit for B1. The lower limit is always 0.0.

k2 Specifies the upper limit fo k2. The lower limit is always 0.0.

TDS Specifies the upper limit for atomic displacement parameters TDS. No unit conversion is
applied. When changing the UNIT from UNIT=NM to UNIT=ANGSTROEM in the control file,
the TDS limit must be changed accordingly (multiplied by 100). The lower limit is always
0.0.

χ2 acceptance limit Draws an additional line on the convergence display graph at the χ2 value
specified here. This is just a visual aid to quickly verify if the fit has reached an acceptable
convergence. Values can be chosen freely. Recommended values are in the range of 1.2–1.5.

Reset Resets all limits to reasonable default values:

Unit cell parameters = 1.00%
Fractional coordinates = 0.05
B1 = 0.010
k2 = 0.00010
TDS = 0.020
χ2 acceptance limit =1.50

3.4.8 GOAL Management

Manage Phase Quantification GOALs If this option is checked, a GOAL to compute relative
phase quantities will be added by Profex when a new phase is added with the ,,Add /
Remove Phase” dialog. When removing a phase using the ,,Add / Remove Phase” dialog
the corresponding quantification GOAL will be removed.

Custom GOALs not identified as quantification GOALs will be preserved and appended to
the list of quantification GOALs.

Note that the syntax of GOALs written by Profex changed with version 3.12.0, as described
below.
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GOAL syntax format The syntax used by Profex to define phase quantification GOALs changed
with Profex version 3.12.0. The previous syntax (,,simple”) is still available for compatibility
reasons, but the new syntax (,,extended”) provides some more flexibility. The syntax version
only affects writing new GOALs. Reading old projects using the simple syntax will work
even if this option is set to ,,extended” format.

The simple syntax used in Profex 3.11 and older defines the sum of all phases and divides
each GOAL by the sum in order to obtain relative phase quantities normalized to 1.0:

sum=Calcite+Aragonite
GOAL[1]=Calcite/sum
GOAL[2]=Aragonite/sum

When adding another phase ,,corundum” and declaring it as an internal standard with a
phase content of 10 wt-%, the GOALs section is re-written as follows:

ISTD=Corundum
ISTDQ=0.1000

sum=ISTD*(1-ISTDQ)/ISTDQ
Amorph=1-(Calcite+Aragonite)/sum
GOAL[1]=Calcite/sum
GOAL[2]=Aragonite/sum
GOAL[3]=Amorph

Using the new extended GOALs syntax, intermediate variables will be used, and the first
example code looks as follows:

sum=Calcite+Aragonite
QCalcite=Calcite/sum
QAragonite=Aragonite/sum
GOAL[1]=QCalcite
GOAL[2]=QAragonite

Instead of Calcite/sum, the GOAL is now called QCalcite, using the prefix ,,Q”. The
prefix is a character prepended to the phase name. The denominator for phase normalization
is called ,,sum”.

Adding 10 wt-% corundum and using it as an internal standard will change the GOALs
section as follows:

ISTD=corundum
ISTDQ=0.1000

sumabs=ISTD*(1-ISTDQ)/ISTDQ
QabsCalcite=Aalcite/sumabs
QabsAragonite=Aragonite/sumabs
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QabsAmorph=1-(Calcite+Aragonite)/sumabs
GOAL[1]=QabsCalcite
GOAL[2]=QabsAragonite
GOAL[3]=QabsAmorph

This time the GOAL name prefix is ,,Qabs” and the denominator is ,,sumabs”. Prefixes and
denominators can be customized as described below.

If the option ,,Also add GOALs for relative phase quantities” is activated, GOALs for relative
and absolute phase quantities will be written when using an internal standard. In that case,
the GOALs section the last example above will look as follows:

ISTD=Corundum
ISTDQ=0.1000

sum=Calcite+Aragonite+Corundum
QCalcite=Calcite/sum
QAragonite=Aragonite/sum
QCorundum=Corundum/sum

GOAL[1]=QCalcite
GOAL[2]=QAragonite
GOAL[3]=QCorundum

sumabs=ISTD*(1-ISTDQ)/ISTDQ
QabsCalcite=Aalcite/sumabs
QabsAragonite=Aragonite/sumabs
QabsAmorph=1-(Calcite+Aragonite)/sumabs

GOAL[4]=QabsCalcite
GOAL[5]=QabsAragonite
GOAL[6]=QabsAmorph

Now it becomes apparent that the new syntax allows easier identification of relative and
absolute phase quantity GOALs. The prefix for relative quantities could also be set to ,,Qrel”
in order to obtain GOAL names QrelCalcite and QabsCalcite for even easier reading.

Relative Phase Quantity GOALs: GOAL name prefix Set the prefix used to label quantification
GOALs when not using an internal standard. Only alphanumeric characters are allowed
(a–z, A–Z, 0–9). Default is ,,Q”.

Relative Phase Quantity GOALs: Denominator variable Set the name of the denominator vari-
able used to calculate quantification GOALs when not using an internal standard. Default is
,,sum”.
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Absolute Phase Quantity GOALs: GOAL name prefix Set the prefix used to label quantification
GOALs when using an internal standard. Only alphanumeric characters are allowed (a–z,
A–Z, 0–9). Default is ,,Qabs”.

Absolute Phase Quantity GOALs: Denominator variable Set the name of the denominator vari-
able used to calculate quantification GOALs when using an internal standard. Default is
,,sumabs”.

Absolute Phase Quantity GOALs: Also add GOALs for relative phase quantities When checked,
both relative and absolute phase quantities will be calculated when using an internal stan-
dard. If not checked, only absolute quantities will be calculated. This option only affects
projects using an internal standard.

3.4.9 Summary Table

Global Parameters and GOALs

Show warnings for values below detection and quantification limit If activated, Profex will
show a warning for phase quantities getting small relative to their ESD. For example, if
the limit of quantification (LOQ) is defined as 0.25, the variation coefficient (ESD / value)
must be smaller than 25 %, or, in other words, the refined value must be greater than 4 · its
ESD. Else a warning ,,< LOQ” will be shown in the summary table. More information can
be found in part 2 of the user manual.

Variation coefficient for LOQ: Defines the threshold for ,,< LOQ” (below limit of quantification)
warnings. Typical values are 0.25 if the refined value must be at least four times its ESD
in order to be quantifiable, or 0.10 if it must be at least 10 times greater than its ESD. This
variable can also be set in the control file (*.sav), see section 4. Values read from the control
file override values specifiec in the preferences dialog. More information can be found in
part 2 of the user manual.

Variation coefficient for LOD: Defines the threshold for ,,< LOD” (below limit of detection) warn-
ings. Typical values are 0.50 if the refined value must be at least twice its ESD in order to
be detectable, or 0.33 if it must be at least three times greater than its ESD. This variable can
also be set in the control file (*.sav), see section 4. Values read from the control file override
values specifiec in the preferences dialog. More information can be found in part 2 of the
user manual.

Minimum ESD (ignore ESDs below) = For phase quantities approaching 0.0, the ESD also ap-
proaches 0.0. Such phases appear to be detectable and quantifiable even at infintesimally
small quantities, but in fact it is an artifact of the ESD computation. In order to avoid this,
a minimum ESD can be specified here. Refined ESDs below this value will be ignored and
hard set to the minimum ESD. Typical values are 0.05 wt-%. Set this value to 0.00 to use all
refined ESD values, regardless of how small they are. More information can be found in part
2 of the user manual.
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Listed GOALs A list of global GOAL names that will be read from the BGMN list file (*.lst) and
shown in the summary table for global parameters and goals. If the text field is empty,
all global GOALs will be shown. This text field supports regular expression patterns. For
example, instead of listing all EPSn values separately:

EPS1
EPS2
EPS3
EPS4

one can use a regular expression to list all refined EPS values:

ˆEPS[1-4]$

or alternatively:

ˆEPS\d$

Regular expressions are useful to identify GOALs describing a phase quantity. Quantity
GOALs managed by Profex always have a unique name ending on /sum. A regular expres-
sion pattern describing GOAL names of type <any name>/sum can thus be used to list only
phase quantity GOALs. The following pattern only matches GOALs with names ending on
/sum:

ˆ[ˆ\/]+\/sum$

For the new GOALs syntax used in Profex 3.12 and newer, quantification GOALs use pre-
fixes ,,Q” or ,,Qabs” (both are customizable) instead of the denominator. These GOALs are
captured with the following expressions:

ˆQ\S+$
ˆQabs\S+$

Numerous tutorials on regular expressions can be found on the internet.

Reset Pressing this button erases the text field with global parameters and GOALs and inserts a
default set of parameters.

Local Parameters and GOALs

Listed GOALs Enter the parameters to be read from the local parameters and goals section in the
BGMN list file (*.lst) and shown in the summary table for local parameters and goals. The
text field supports regular expression patterns. For example, instead of listing all unit cell
parameters separately:
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A
B
C
ALPHA
BETA
GAMMA

one could use a regular expression pattern

ˆA|B|C|ALPHA|BETA|GAMMA$

or alternatively:

ˆ[A-C]$
ˆALPHA|BETA|GAMMA$

However, with regular expression patterns the parameters may be listed in arbitrary order.
Regular expressions are particularly useful for GrainSize results. Printing all refined Grain-
Sizes is achieved by the following pattern:

ˆGrainSize\(\d,\d,\d\)$

Reset Pressing this button erases the text field with local parameters and GOALs and inserts a
default set of parameters.

3.5 Fullprof

Fullprof Executable Specifies the path to the Fullprof executable fp2k.exe.

Structure files directory Specifies the location of the directory with structure template files.

Device files directory Specifies the location of the directory with device template files.

Stop on convergence Normally Fullprof aborts the refinement when convergence criteria are
reached. Checking this option forces Fullprof to always perform the number of refinement
cycles specified with the parameter Ncy.

Divergence slit angle As Fullprof expects all scans to be measured with a fixed divergence slit
setting, Profex will attempt to convert scans measured with automatic or variable divergence
slit. The slit opening in degrees specified here is the opening the scans will be converted to.
A value less than 1.0 degree is recommended.
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3.6 Chemical Composition

The chemical composition page allows to edit the oxide forms and their molecular weights used
to calculate the elemental composition of the sample. Elements with empty molecular weight,
or with molecular weight of 0.0 g/mol, will be ignored. It is recommended to leave the oxide
and molecular weight cells of oxygen (element No. 8) empty to suppress display of oxygen as a
separate element in the chemical composition results table.

A dialog to select the oxide form and automatically calculate the corresponding molecular weight
can be opened by double-clicking on the element symbol (left column).

Double-clicking an oxide cell (middle column) or molecular weight cell (right column) allows to
enter oxide names and molecular weights directly by bypassing the dialog mentioned above.

Element, Oxide, and Molecular Weight table This table holds the oxide formula and oxide molec-
ular weight for each element. Edit the values by double clicking a cell. Double clicking an
element cell will open a dialog to determine oxides and their molecular weight. Double
clicking any other cell allows direct input of oxide formulas and values.

Reset Resets the table to the internal default values. All customizations will be lost.

3.7 Text Blocks

On this page text blocks can be managed. See part 2 of the user manual for more information on
how to use text blocks. Click the + button to create a new text block, then enter the text in the edi-
tor. All changes will be saved automatically when closing the preferences dialog. Click− to delete
the current text block. The block will be deleted permanently when closing the preferences dialog
with the ,,OK” button. Close the dialog with ,,Abort” if the text block was deleted accidentally.
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4 Profex-specific Control File Variables

Profex reads some additional variables from BGMN control files (*.sav) that are not mandatory for
the BGMN refinement backend. Some of them are only parsed by Profex and ignored by BGMN,
and some of them are used for specific calculations of GOALs.

4.0.1 Refinement Control Files (*.sav)

sum This variable is used to compute relative phase quantities normalized to 100 %. Normally
it holds the sum of the GEWICHT variables of all phases. If one phase is set as an internal
standard, the sum variable is used for the normalization to the internal standard quantity.
sum is automatically managed by Profex if phases are added, removed, or set and unset as
internal standard.

ISTD Holds the phase name of the internal standard phase. It is only present if an internal stan-
dard has been defined. It is added and removed by Profex if an internal standard is set or
unset.

ISTDQ Holds the phase quantity of the internal standard phase normalized to 1.0 (not to 100 %).
It is only present if an internal standard has been defined. It is added and removed by Profex
if an internal standard is set or unset.

LOQ Relative standard deviation (ESD / value) considered as the limit of quantification (LOQ).
This value will override the value set in the preferences dialog. It will only be parsed if the
option ,,Show warnings for values below detection and quantification limit” is set active in
the preferences dialog. If the ratio ESD / value of a refined phase quantity exceeds LOQ,
it will be highlighted in the summary table and a warning ,,< LOQ” will be shown.

LOD Relative standard deviation (ESD / value) considered as the limit of detection (LOD). This
value will override the value set in the preferences dialog. It will only be parsed if the
option ,,Show warnings for values below detection and quantification limit” is set active in
the preferences dialog. If the ratio ESD / value of a refined phase quantity exceeds LOD,
it will be highlighted in the summary table and a warning ,,< LOD” will be shown.

MINESD Sets the minimum ESD that is considered realistic for refined phase quantities. This vari-
able overrides the value set in the preferences dialog ,,Minimum ESD (ignore ESDs below)
=”.

SampleID: A custom sample ID string can be entered to add random sample information to the
refinement. Profex is able to extract sample ID information from some raw data formats,
such as Bruker *.raw and *.brml. In that case it will add the SampleID tag automatically
when the BGMN control file (*.sav) is created. SampleIDs are also exported to CSV tables
when using the results export features.

Example:

% SampleID: Sample No 160810-01, room temperature
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Note that all comment signs (also at the beginning of the line) will be ignored. Profex will
extract the string following SampleID: regardless of comment signs. In the example above,
the extracted sample ID string will be Sample No 160810-01, room temperature.

Warning: Avoid semicolons (;) in the sample ID string. This character is used as a field
separator in the CSV results tables. Using it in the sample ID will confuse the layout of the
CSV tables.

4.0.2 Instrument Configuration Files (*.sav)

ZTSTRETCH The width of the raytraced profiles will be scaled by this value or function prior to
profile interpolation. This can be helpful for unconventional goniometer setups, when the
fundamental parameters are unknown or unable to accurately describe the profile.

Instead of a constant scale factor, a zweiTheta dependent function can be specified in
JavaScript syntax. The value for zweiTheta is read in degrees.

For example, to increase the profile width with increasing diffraction angle 2θ following a
tan(2θ) characteristic, use the following equation:

ZTSTRETCH=1+Math.tan(Math.PI*zweiTheta/180.0)

For more information on the JavaScript syntax, refer to [6, 7].
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5 Technical Information

5.1 Scan File Conversion

In contrast to the BGMN Rietveld backend, which only supports a limited number of scan file
formats natively, Profex reads a wide and growing list of file formats. When running a refinement
on a scan file format not supported by BGMN, Profex will by default automatically convert the file
in the background and modify the control file accordingly. This section describes the conversion
process and the settings allowing the user to control the conversion.

Automatic scan file conversion can be switched on and off in the preferences dialog by checking
or unchecking the option ,,Edit→ Preferences. . .→ BGMN→ Convert raw scans to XY format”.
Scan file handling by Profex will be different depending on this setting. Unless conversion is not
desired for specific reasons, users are strongly advised to activate this option.

It is a surprisingly complex task to determine the correct file name of a project’s raw scan (VAL[n]
keyword in the control file). The possible scenarios to be considered are manifold. Profex has
sophisticated routines to determine the best guess for a VAL file name under all circumstances.
These routines are illustrated in Figures 10–13.

In principle, when creating a new project, a raw scan file as obtained from the instrument is opened
and a new control file is created either by using the ,,Add a new phase” dialog or the ,,Copy
control file” function. Either way the loaded raw scan file determines the location and the base
name of the project, and all input and output file names in the control file will automatically be
set to this scan’s file base name. The scan file name to be read by the BGMN Rietveld backend is
specified with the VAL[n]=ScanFile.xxx line in the control file. The scan file name is given by
the project name, as described above, but the file format and extension is determined by Profex
automatically, depending on the raw scan format and the setting of ,,Edit → Preferences. . .→
BGMN→ Convert raw scans to XY format”. If a format natively supported by BGMN is detected,
the file will be used without conversion. If the format is not supported, the behavior will depend
on the setting ,,Convert raw scans to XY format”: If active, the file will be converted to *.xy format
and the VAL[n] file entry will be adapted accordingly. If inactive, no conversion will be done and
it is in the user’s responsibility to guarantee correct file names and formats. See Fig. 9 for more
explanations.

However, the processes described above represent relatively simple scenarios, when the raw scan
file is opened and the format and file name are known. In many situations it determining the
correct file name is not as straight-forward. The following situation represents a worst case: A
DIA file is opened, conversion to *.xy is inactive, and the control file is created from another project
using the ,,Copy control file” feature. Normally, when a DIA file exists, a control file should also
exist with a valid VAL[n] entry. However, when sharing or moving DIA files, or when the base
name of the DIA and control file do not match, it may still occur that a DIA file is present but the
corresponding control file cannot be located. Trying to find the correct raw scan file used to create
die DIA file is difficult in such a situation:
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1. The control file copied over from another project contains input and output file names (VAL,
DIAGRAMM, OUTPUT, etc.) of the source project. All file names must be changed to the
destination project. The VAL file name found in this control file must not be used.

2. The displayed scan is a DIA file, which cannot be used as input file.

3. Converting the DIA file to *.xy is not allowed.

4. There is no reference to the raw scan in any of the available files.

5. In that case, Profex will scan the directory of the DIA file for a raw scan file in a format
natively supported by BGMN. But there is no guarantee that such a file is found.

This is one of many scenarios when finding the correct VAL file name is not trivial. However,
the complex processes illustrated in Figures 10–13 cover most situations, and if no solution can be
found, a warning will be issued.
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If the raw scan format (here: xrdml) is not natively supported by BGMN, Profex will change the
VAL[n] file name to *.xy and convert the file automatically.

working directory
scan 1.sav
scan 1.xrdml
structure 1.str
instrument.sav
instrument.geq
instrument.ger

% Input files
VAL[1]=scan 1.xy
VERZERR=instrument.geq
LAMBDA=CU
STRUC[1]=structure 1.str
% Output files
LIST=scan 1.lst
OUTPUT=scan 1.par
DIAGRAMM=scan 1.dia
...

If conversion to *.xy is deactivated, VAL[n] will be the raw scan file. If it is not supported natively
by BGMN (e. g. xrdml), refinement will not start.

working directory
scan 1.sav
scan 1.xrdml
structure 1.str
instrument.sav
instrument.geq
instrument.ger

% Input files
VAL[1]=scan 1.xrdml
VERZERR=instrument.geq
LAMBDA=CU
STRUC[1]=structure 1.str
% Output files
LIST=scan 1.lst
OUTPUT=scan 1.par
DIAGRAMM=scan 1.dia
...

Natively supported file formats (here: Seifert val) do not require conversion to *.xy. Profex will
use the raw scan file name for the VAL[n] entry, regardless of the state of the ,,Convert raw scans
to XY” setting.

working directory
scan 1.sav
scan 1.val
structure 1.str
instrument.sav
instrument.geq
instrument.ger

% Input files
VAL[1]=scan 1.val
VERZERR=instrument.geq
LAMBDA=CU
STRUC[1]=structure 1.str
% Output files
LIST=scan 1.lst
OUTPUT=scan 1.par
DIAGRAMM=scan 1.dia
...

Figure 9: Some examples for working and failing VAL[n] file scenarios.
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Start ,,Generate de-
fault control file” in
,,Add Phase” dialog

Temporarily store pre-
vious VAL[n] = file

name if available

Apply control file con-
tent from template

Previous VAL file
name available?

VAL[n] = previous VAL file

VAL[n] = remains empty

Proceed to ,,Verify VAL file”

yes

no

Figure 10: VAL file handling when calling the ,,Add Phase” dialog and activating the option ,,Gen-
erate default control file” to create a control file from a template file.
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Start ,,Copy control file”
Temporarily store

file name of previous
VAL[n] = entry if available

Apply new con-
trol file content

Previous VAL[n] =
empty?

VAL[n] = previous VAL file

Convert to *.xy?
VAL[n] = dis-
played scan file

Disp. scan file =
native BGMN

format?

VAL[n] = dis-
played scan file

Search natively supported
file with the same base

name at the same location
as the displayed scan file

Alternative scan file
found?

VAL[n] = alter-
native scan file

Leave VAL[n] =

empty, display warning
Proceed to ,,VAL
file verification”

no

yes

yes

no

yes

no

yes

no

Figure 11: VAL file name handling when using the ,,Copy control file” function.
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Start ,,VAL file verification”

VAL[n] = empty?
VAL[n] = dis-
played scan file

Convert to *.xy?

Change basename of
VAL[n] file to project base-
name, keep extension and
format of previous entry

VAL[n] = native
BGMN format?

VAL[n] = file
exists?

Displayed scan
format native?

VAL[n] = dis-
played scan file

VAL[n] = pro-
jectBasename.xy

Proceed to ,,Cre-
ate VAL file”

yes

no

yes

no

yes

no

yes

no

yes

no

Figure 12: Automatic verification of a VAL[n] file entry in the SAV control file. This function is
called at several occasions when modifying the control file content. E. g. after creating a default
control file, or after applying a control file from another project.
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Start ,,Create VAL file”

VAL[n] = file exists
on hard disk?

Convert displayed
scan file to *.xy

Launch BGMN re-
finement process

yes

no

Figure 13: Immediately before running the refinement process, Profex checks whether the VAL
file referenced in the control file exists on the hard disk. If not, a *.xy file will be created from the
currently displayed scan file.
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5.2 Refinement Presets

Preset files store data in XML format. Their storage location can be configured in ,,Edit→ Prefer-
ences. . .→ BGMN→ Configuration→ Presets directory”. When opened in a text editor, the file
must have the following structure:

<?xml version="1.0" encoding="UTF-8"?>
<preset name="anyName">

<device MD5hash="..." RelativePath="...">myInstrument.geq</device>
<device MD5hash="..." RelativePath="...">myInstrument.ger</device>
<device MD5hash="..." RelativePath="...">myInstrument.sav</device>
<template MD5hash="..." RelativePath="...">myTemplate.tpl</template>
<structures>

<structure MD5hash="..." RelativePath="...">myPhaseA.str</structure>
<structure MD5hash="..." RelativePath="...">myPhaseB.str</structure>
<structure MD5hash="..." RelativePath="...">myPhaseC.str</structure>

</structures>
<other>

<textfile MD5hash="..." RelativePath="...">background.xy</textfile>
<textfile MD5hash="..." RelativePath="...">description.txt</textfile>
<binaryfile MD5hash="..." RelativePath="...">report.docx</binaryfile>

</other>
</preset>

At least one <device> and <template> node must be present. If one of them is missing, ap-
plying the preset will abort. If more than one template node is present, all but the first will be
ignored. An arbitrary number of <structure> and <other><...file> nodes may be present.
All paths can either be absolute or relative to the location of the preset file. Device and template
files do not need to have the same file name. It is possible to use different template files with the
same device file.

Files specified in

<other>
<textfile>...</textfile>

</other>

and

<other>
<binaryfile>...</binaryfile>

</other>

tags will be copied to the project directory. These tags can be used for arbitrary files, such as
descriptions, background scans, raw data, report files etc. It is important to specify whether the
file is stored in text or binary format. For text format files Profex will convert the line endings
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to the target platform to maintain platform independence. Binary files will be copied without
modification. If unsure, use <binaryfile>, as the copied file will not be modified.

Note that custom profile functions (,,Edit→ Preferences. . .→ BGMN→ STR File Handling”) will
not be applied when using presets, as it would undermine the purpose of reproducing precisely
defined refinement scenarios.

A typical file structure of a preset named ,,scenarioA” is shown below:

Presets
scenarioA

scenarioA.pfp
instrA.geq
instrA.ger
instrA.sav
scenarioA.tpl
phaseA.str
phaseB.str
instrA-bkgr.xy

The preset file ,,scenarioA.pfp” references all other files being part of the preset:

<!DOCTYPE ProfexPreset>
<preset version="20160910" name="scenarioA">

<device MD5hash="fc74..." RelativePath="">instrA.geq</device>
<device MD5hash="0523..." RelativePath="">instrA.ger</device>
<device MD5hash="c2fb..." RelativePath="">instrA.sav</device>
<template MD5hash="f089..." RelativePath="">scenarioA.tpl</template>
<structures>

<structure MD5hash="1fdb..." RelativePath="">phaseA.str</structure>
<structure MD5hash="787e..." RelativePath="">phaseB.str</structure>

</structures>
<other>

<textfile MD5hash="cc87..." RelativePath="">
instrA-bkgr.xy

</textfile>
</other>

</preset>

The optional node argument MD5hash stores a checksum of the file in hexadecimal format. The
checksum will be verified each time the preset is applied. In case of a mismatch, a warning is
presented informing the user that the file has been modified and offering to cancel or proceed.
The optional argument RelativePath stores the file’s destination path relative to the scan file
the preset is applied to.
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5.2.1 Source and destination paths

Refinement presets offer some flexibility in terms of referenced file locations (structure, device,
other files), both at the source (in the presets directory) and destination (in the project directory)
of the preset. The preset file ,,scenarioA.pfp” will be used as an example. If the file name of,
for example, a structure file is specified without a path, the structure file will be searched at the
location of the preset file:

<structure RelativePath="">
phaseA.str

</structure>

Presets
scenarioA

scenarioA.pfp
phaseA.str

If the file name is specified with a relative path (here ,,structures”), it will be searched in a sub-
directory starting from the preset file:

<structure RelativePath="">
structures/phaseA.str

</structure>

Presets
scenarioA

scenarioA.pfp
structures

phaseA.str

It is also possible to specify absolute file paths to locate the structure file. In that case, the structure
file will be searched at the absolute path location, regardless of the location of the preset file:

<structure RelativePath="">
C:\Profex-BGMN\Profex\Presets\scenarioA\phaseA.str

</structure>

The destination of the structure file (or any other file) is specified by the ,,RelativePath” argument.
It will be used when the preset is applied to a scan file (here ,,myScan.raw”) to specify the location
relative to the scan file after the preset has been applied. If no relative path is given, the structure
file will be copied to the location of the scan file:

<structure RelativePath="">
phaseA.str

</structure>

myProject
myScanA.raw
phaseA.str

If a relative path is specified, a sub-directory will be created for the structure file:

<structure RelativePath="structures">
phaseA.str

</structure>

myProject
myScanA.raw
structures

phaseA.str

The relative path of the structure file at the source location will be ignored. The structure file will
be copied to the relative path specified as ,,RelativePath=”:
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<structure RelativePath="destination/phases">
source/structures/phaseA.str

</structure>

myProject
myScanA.raw
destination

phases
phaseA.str

There is one exception when the relative path at the source location is not ignored: If no relative
path is specified (empty or absent) and the structure file is located in a sub-directory in the preset
directory, this sub-directory will be used as a relative path. This is necessary in order to maintain
backward compatibility with previous versions of Profex presets:

<structure RelativePath="">
structures/phaseA.str

</structure>

myProject
myScanA.raw
structures

phaseA.str

Warning: It is possible to specify destination locations of files outside of the project directory:

RelativePath="..\structures"

This is likely to cause problems by overwriting files used by other projects. It is strongly advised
not to specify relative paths outside of the project directory.
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5.3 Automatic conversion of thermal displacement parameters

During the conversion from CIF or XML to STR format Profex automatically transforms the ther-
mal displacement parameters to the format supported by BGMN. Depending on the source for-
mat, the following conversions are calculated (anisotropic βij values are not supported by the CIF
format.):

Isotropic B: Isotropic B is the format supported by BGMN. However, BGMN uses a different
unit than normally provided in the CIF file. Automatic conversion therefore performs the
following conversion:

Biso[nm2] = 0.01 · Biso[Å2]

Anisotropic Bij: Anisotropic Bij are converted to isotropic B values in the expected unit [8]:

Biso[nm2] = 0.01 · 1
3 ∑

i
∑

j
Bija∗i a∗j Ai Aj

with reciprocal lattice parameters a∗[Å−1] and real lattice parameters A[Å].

Anisotropic Uij: Anisotropic Uij are converted to Uequiv using the expression [8]:

Uequiv =
1
3 ∑

i
∑

j
Uija∗i a∗j Ai Aj

with reciprocal lattice parameters a∗[Å−1] and real lattice parameters A[Å]. Uequiv is con-
verted to Biso by the following equation.

Isotropic Uequiv: Isotropic Uequiv values are converted to isotropic B:

Biso[nm2] = 0.01 · 8.0 · π2 ·Uequiv
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5.4 Bundle File Structure

5.4.1 Windows

Profex-4.0.x.zip
Profex-4.0.x

profex.exe
...
BGMNwin

BGMN.EXE
MakeGEQ.EXE
...

Devices
Instrument 1.sav
Instrument 1.ger
Instrument 1.geq
Instrument 1.tpl
Instrument 2.sav
...

Structures
Structure 1.str
Structure 2.str
...

Presets
Preset 1.pfp
Preset 2.pfp
...
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5.4.2 Mac OS X

Profex-4.0.x.dmg
Profex.app

Contents
MacOS

profex
Resources

BGMNwin
bgmn
makegeq
...

BGMN-Templates
Devices

Instrument 1.sav
Instrument 1.ger
Instrument 1.geq
Instrument 1.tpl
Instrument 2.sav
...

Structures
Structure 1.str
Structure 2.str
...

Presets
Preset 1.pfp
Preset 2.pfp
...
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5.4.3 Linux

No bundles are available for Linux. The program needs to be compiled from source, and BGMN
templates can be downloaded from the Profex website. A recommended manual installation us
shown below.
/

opt
Profex

profex
profex.png

BGMNwin
bgmn
makegeq
...

BGMN-Templates
Devices

Instrument 1.sav
Instrument 1.ger
Instrument 1.geq
Instrument 1.tpl
Instrument 2.sav
...

Structures
Structure 1.str
Structure 2.str
...

Presets
Preset 1.pfp
Preset 2.pfp
...

usr
local

share
applications

profex.desktop

63



References

[1] http://www.bgmn.de/

[2] https://www.ill.eu/sites/fullprof/

[3] http://profex.doebelin.org/

[4] Andrew, V.J. ,,The Re1ative Intensities of the Lα1, β1, β2, and γ1, Lines in Tantalum, Tungsten,
Iridium, and Platinum”. Phys. Rev. 42(5), 591 (1932).

[5] http://www.castep.org/

[6] https://www.w3schools.com/js/js arithmetic.asp/

[7] https://www.w3schools.com/js/js math.asp/

[8] Fischer, R.X., Tillmanns, E. The equivalent isotropic displacement factor. Acta Cryst. C44, 1988,
775–776.

64



Index

Bij, 60
Biso, 60
Uequiv, 60
Uij, 60

Abort, 27
About Profex, 30
Add Phase, 25
Anisotropic, 19
AntiAliasing, 32
Atomic Scattering Factor, 28
Axis

Font Labels, 33
y-axis Scaling, 32

Backend, 9
Background Color, 33
Backup, 26
Baseline, 29
Batch Conversion, 23
Batch Refinement, 26
BGMN Variables, 29
BGMN.EXE, 35
Bundle, 61

Linux, 63
Mac OS X, 62
Windows, 61

Chemical Composition, 6
Chemical composition, 9
CIF File

Import, 23
Color, 8
Context Help, 6, 9, 29
Context menu, 17
Control File

Profex specific variables, 47
Text editor features, 17

Convergence, 10, 29, 40
Coordinates, 15
Copy, 23
Copy Control File, 24
Counting Noise, 14

CPU Cores, 31
Cross Hair, 14
Cursor, 14
Cut, 23

Default Project Type, 31
Device Database, 37
Displacement

Left, 25
Reset, 25
Right, 25
Vertical, 25

Dockable Window, 5, 6, 10
Closing, 6
Detaching, 6
Moving, 6
Opening, 6
Stacking, 6

Double Click, 14, 15
dw-PeakIntegrals, 11
dw-PeakList, 12
dw-RefinedParameters, 12
dw-SearchMatch, 12

EFLECH, 37
EFLECH.EXE, 35
EPS, 6
EPS2, 20
Export, 27

ASCII, 35
CELL File, 27
Chemical composition, 27
CIF File, 27
Global Parameters, 27
Local Parameters, 27
Peak Integrals, 27
Raster images, 35

Favorites, 20, 39
Field separator, 35
Find, 24
Fix parameter, 19
Font, 32

65



Axis Labels, 33
hkl Indices, 33
Legend, 33
Title, 33

Font Scale Factor
Printing, 35
SVG Export, 35

GEOMET.EXE, 35
GOAL, 6, 27, 29
GOAL management, 40
GOALs, 40
Graph File

Open, 22
Remove, 22
Save, 22
Save As, 22

Grid lines, 32

hkl Indices, 9, 12, 24, 39
Font, 33
Range, 39

ICDD
Import, 23

Icon theme, 31
Insert Scans, 22
Instrument Configuration, 28
Internal Standard, 26
Isotropic, 19

Legend, 12, 24
Font, 33

Line Style, 8
Line Width, 8

Display, 32
Printing, 34

Linux
Bundle file structure, 63

List Coordinates, 15

Mac OS X
Bundle file structure, 62

Main Window, 5, 7, 12
MAKEGEQ.EXE, 35
Margin Color, 24, 33

Menu, 22
Edit, 23
File, 22
Help, 29
Instrument, 28
Project, 25
Results, 27
Run, 26
Tools, 28
View, 24
Window, 29

Menu Bar, 5
Multi-Scan Files, 33

Open file, 17

Parameters
Chemical composition, 27, 29
Global, 6, 27, 29
Local, 6, 27, 29

Paste, 24
Peak detection, 37
Phase Pattern, 8, 12, 24
Plot, 24
Plot Area, 5, 12
Plot Options, 5, 8, 29
Preferences, 24, 31

BGMN, 35
Chemical Composition, 46
Favorites, 39
Fonts, 33
Fullprof, 45
General, 31
Graph, 32
Limits, 10
Reference Structure, 39
Refinement Limits, 39
Repositories, 37
Scan Styles, 34
Search-Match, 38
Summary Table, 43
Text Blocks, 46
Text Editors, 32

Presets, 26, 56
Presets Database, 37

66



Print, 23
Printing

Font Scale Factor, 35
Line Width, 34

Project
Close, 23
Close All, 23
Open, 22

Projects, 5, 8, 29

Quit, 23

Raster Export, 35
Recent

Graph Files, 22
Text Files, 23

Redo, 23
Reference Structure, 14, 20, 39

Automatic Indexing, 39
Clear Buffer, 39
Favorites, 20
hkl Range, 39
Index, 20
Reset, 20

Refine parameter, 19
Refinement, 26

Abort, 27
Run, 26
Run Batch, 26

Refinement presets, 56
Refinement Protocol, 5, 9, 29
Remove Phase, 25
Remove Scan, 22
Replace, 24
Reset File, 24
Restore open projects, 31
Run, 26

Scaling, 32
Scan

Insert, 22
Remove, 22

Scan File
Open, 22

Scan File Conversion, 49

Scan Style, 34
Color, 34
Point Style, 34
Standard Color, 34

Search-Match, 38
Search-match, 26
Space Groups, 28
SPACEGRP.DAT, 28
Spectral line cursor, 14, 35
Stacking

Left, 25
Reset, 25
Right, 25
Vertical, 25

Stacking scans, 17
Standard Color, 34
Status Bar, 6
Structure Database, 37
Structure File

Close All, 26
Edit All, 26
Open All, 26

Structure file
Text editor features, 19

SVG Export
Font Scale Factor, 35

Symbol Size, 32
Syntax highlighting, 32
System information, 30

TDS, 60
TEIL.EXE, 35
Text Blocks, 24
Text Editor, 5
Text editor, 17
Text File

Open, 22
Save, 22
Save As, 22

Thermal Displacement Parameters, 60
Thumbnail, 33
Title

Font, 33
Tool Bar, 5, 20

Layout, 31

67



Reference Structure, 20
Reference Structure Tool Bar, 5

Tungsten, 14

Un-Zoom, 14
Undo, 23
User Interface, 5

Variables, Profex specific, 47
Visibility, 8

Wavelength, 31, 35
Windows

Bundle file structure, 61

XML File
Import, 23

Zoom, 13, 24
Zoom Range, 24

68


	Main Window
	User Interface Elements
	Dockable windows
	Projects
	Plot options
	Refinement protocol
	Chemical composition
	Context Help
	Convergence Progress
	Peak integrals
	Peak list
	Search-Match
	Refined parameters

	The Plot Area
	Central Data Area
	Left Margin Area
	Bottom Margin Area
	Stacking Scans

	Text Editors
	Control File specific features
	Control and Structure File specific features

	Tool bars

	Menu Structure
	File
	Edit
	View
	Project
	Run
	Results
	Instrument
	Tools
	Window
	Help

	Preferences
	General
	Text Editors
	Graphs
	Appearance
	Fonts
	Scan Styles
	Print and Export

	BGMN
	Backend Configuration
	Repositories
	Peak detection
	Search-Match
	Reference Structures
	Favorites
	Refinement Limits
	GOAL Management
	Summary Table

	Fullprof
	Chemical Composition
	Text Blocks

	Profex-specific Control File Variables
	Refinement Control Files (*.sav)
	Instrument Configuration Files (*.sav)

	Technical Information
	Scan File Conversion
	Refinement Presets
	Source and destination paths

	Automatic conversion of thermal displacement parameters
	Bundle File Structure
	Windows
	Mac OS X
	Linux


	Index

